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NEWS IN BRIEF
Volunteers Needed for 2020 Homeless Count

The Encino and Tarzana areas are seeking volunteers
for the 2020 Greater Los Angeles Homeless Count that will
take place on Tuesday, January 21. This count takes place every
January and is implemented to report how large the homeless
population has grown in order to receive any federal funding
through the Department of Housing and Urban Development.
The count in Encino will meet at Valley Beth Shalom (15739
Ventura Blvd) from 7:30 to 11:30 pm while the count in Tarzana
will meet at St. Mary’s Assyrian Church of the East (5955 Lindley
Ave) from 8 pm to 12 am. Those interested in volunteering can
register at theycountwillyou.org.

Stern-Authored Bills to Address Sweeping
Power Shutoffs Amid Growing Wildfire Risks
Senator Henry Stern, representing the 27th District that
includes Encino, proposed three new bills recently that focus on
the advancement of community-based resiliency efforts in the
light of growing wildfire risks. With the increasing prevalence
of power shutoffs during times of fires, these bills aim to ensure
that public agencies and first responders are communicating
effectively during these emergencies.
The bills that passed committee are SB 596, which
will require a county human service agency to provide medical
baseline information to In-Home Support Service applicants
(IHSS), SB 739, which will require Cal Fire to develop a training
program to train individuals to support defensible space and
home hardening assessment and education efforts and SB 753,
which allows county officials to share telephone and email
contact information for people who may be at greater risk when
a power shutoff is declared. These three bills passed their first
committee votes this week.

Run For a Good Cause

Join weSPARK Cancer Support Center for their 10th
annual Run/Walk at Lake Balboa on Sunday, January 26. Grab
your friends and family and get moving for a good cause! There
will be a 5K, 10K and Kids Fun Run with each flat course perfect
for either the experienced runner or casual walker. Plus, dogs and
strollers are also welcome on each course!
Each runner will receive a t-shirt, a finisher medal, and
there will be age division awards for those runners at the front of
the pack. Music will be provided by K-EARTH, AMP Radio &
JACK FM. There will also be food trucks, a vendor expo, raffles,
giveaways and so much more! All proceeds benefit weSPARK
Cancer Support Center, which enhances the quality of life for
cancer patients, survivors and their loved ones. WeSPARK
provides free programs and services, which alleviate the physical
and emotional side effects of a cancer diagnosis.
Race begins at 9 am, walk-ups welcome between 7:30
to 8:50 am the day of the race.

Grocery Store Shake-Up

Encino residents were
seemingly blindsided to hear
that Ralph’s at Hayvenhurst and
Ventura will soon be shutting its
doors. During the first week of
January, employees were told
just days before customers that
the Encino Ralph’s location is
officially closing on January 31.
Encino
Enterprise
spoke with a Ralph’s employee
that stated their lease
was up and the rent was
just too high to be able
to stay in their current
location. Current rent is
approximately $200,000,
the employee said, for the
building and parking lot.
The proposed increase
was an additional $50,000
per month. Ralph’s and
center owner Caruso
Affiliated has reportedly
been in negotiation talks
for months, but were
unable to come to a resolution.
While there is currently
no official announcement on what
business will be taking over the
location, rumor on social media
site Nextdoor is buzzing that
Amazon could be taking over the
lease. Fellow business employees
in the complex seem to have
heard the same rumblings but go
back on forth on whether it will be

Photos from top: Ralph’s Encino which will be
shutting its doors on January 31, the closed Office
Depot building that was rumored to become a
Trader Joe’s and interior of Ralph’s storewide sale.

outlet.

an Amazon
distribution
center
or
grocery

It was just in November
that Amazon officially announced
they would be opening their first
grocery store in Woodland Hills
so a second location in Encino
might not be a far stretch. Valley
News Group was the first to report
on Amazon’s possible lease of the
old Toys R’ Us location as early
as September.

At the moment, all items
except perishables are currently
25% off in an effort to clear the
shelves of remaining product.
In other grocery news,
the Encino Office Depot location
at 16571 Ventura Blvd that
closed its doors at the end of last
year was rumored to possibly
become a Trader Joe’s. A Trader
Joe’s representative told Encino
Enterprise they are definitely
not moving into that specific
space but are currently looking in
Encino for a second location.
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JANUARY

Vacation
Vibes & Values!
GET UP TO

$100 IN VALUE

1
PER BOOKING

ON PLEASANT HOLIDAYS AAA VACATIONS® !

CHOOSE FROM DESTINATIONS LIKE:

Hawai’i

• 5 nights from $797 LAND ONLY
2

Caribbean

3

USA

4

• 5 nights from $558 LAND ONLY
• 5 nights from $782 LAND ONLY
YOUR VACATION MAY INCLUDE:

Daily Breakfast; Kids Stay Free5; Resort
Coupons; All-Inclusive Meals & Free Wi-Fi!

AAA TRAVELS WITH YOU

CALL: (800) 741-1605
CLICK: AAA.com/TravelBenefits
VISIT: Your Local Auto Club Branch
O'AHU, HAWAI'I
Must be booked by February 29, 2020 with travel complete by December 31, 2020. Minimum five night stay at participating AAA Vacations® properties required. $100 activity voucher is
nonrefundable, nontransferable, has no cash value and applies to the following destinations: Mexico, Hawai‘i, Central & South America and select Caribbean destinations. Savings not
reflected in rates shown and applies to the following destinations $50 savings: USA (excluding Hawai’i), Canada; $100 savings: Australia, New Zealand, Europe, Asia, select Caribbean
destinations (Anguilla, Barbados, Bermuda, Bonaire, British Virgin Islands, Curaçao, Grand Cayman, Grenada, Martinique, St. Barts, St. Croix, St. Kitts & Nevis, St. Martin and St. Maarten, St.
Vincent and the Grenadines, and Turks & Caicos), Tahiti (French Polynesia), Fiji and Cook Islands. 2Rate is per person, land only, based on double occupancy, for check-in on May 4, 2020
in standard king room accommodations at Outrigger Reef Waikiki Beach Resort in O’ahu and includes government taxes. 3Rate is per person, land only, based on double occupancy, for
check-in on May 4, 2020 in deluxe tropical view room accommodations at Dreams Punta Cana Resort & Spa Unlimited-Luxury® in Dominican Republic and includes government taxes.
4
Rate is per person, land only, based on double occupancy, for check-in on May 7, 2020 in guest room accommodations at INNSIDE by Meliá New York NoMad and includes government
taxes. 5Kids stay free in same room as adults using existing bedding. Occupancy limits apply.
Unless otherwise indicated: Rates quoted are accurate at time of publication & are per person, based on double occupancy. Airfare, taxes, fees, surcharges, gratuities, transfers &
excursions are additional. Advertised rates do not include any applicable daily resort or facility fees payable directly to the hotel at check-out; such fee amounts will be advised at the
time of booking. Rates, terms, conditions, availability, itinerary, taxes, fees, surcharges, deposit, payment, cancellation terms/conditions & policies subject to change without notice at
any time. Cruise rates capacity-controlled. Advance reservations through AAA Travel required to obtain Member Benefits & savings which may vary based on departure date. Rates
may be subject to increase after full payment for increases in government-imposed taxes or fees & supplierimposed fees. Blackout dates & other restrictions may apply. Not responsible for errors or omissions. Your
local AAA club acts as an agent for Pleasant Holidays®. CST 1016202-80. To learn how we collect and use your
information, visit the privacy link at AAA.com. ©2019 Auto Club Services, LLC. All Rights Reserved.
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* The Encino Chamber of Commerce will be holding their
Education Committee Meeting on Thursday, January 23, from 2 to
3 pm at the Chamber office (4933 Balboa Blvd). The Committee is
dedicated to the education of Encino and surrounding community.
* Burnt Toastmasters is seeking new members. The group
meets Thursdays from 7 to 9 am at Label’s Table Deli, 19005 Ventura
Blvd. Learn the ins and outs of public speaking with this 60-year-old
group. For more information call Ron Rosate (818) 284-0275.
* The Southern California Garden Club continues its 93rd
season with a Garden Club meeting featuring the program, “All You
Ever Wanted to Know about Mosquitoes,” on Tuesday, January 21,
starting at 11 am at the Sepulveda Garden Center (16633 Magnolia
Blvd). The program is preceded at 9:30 am by a plant market
and country store (for fundraising) and plant specimen display, a
business meeting at 10 am and a workshop, “Getting to Know You,”
at 10:30 a.m. Lunch (bring your own) follows the program at 12 pm.
The club provides beverages and desserts. No admission charge for
guests. All are welcome.
* Join the West Valley Regional Library for a movie
screening of “Scary Stories to Tell in the Dark” on Sunday,
January 19, from 2 to 4 pm. The shadow of the Bellows family has
loomed large in the small town of Mill Valley for generations. It’s
in a mansion that young Sarah Bellows turns her tortured life and
horrible secrets into a series of scary stories. These terrifying tales
soon have a way of becoming all too real for a group of unsuspecting
teens who stumble upon Sarah’s spooky home. This movie is rated
PG-13.
* The Encino Neighborhood Council’s next General Board
Meeting is taking place on Wednesday, January 22, starting at 7 pm
at the Encino Women’s Club (4924 Paso Robles Ave).
* Dave Weeshoff, San Fernando Valley Audubon
Conservation Chair will present the National Audubon Society 2019
Climate Report, “Survival by Degrees: 389 Bird Species on the
Brink” on Thursday, January 23, from 7 to 9 pm at the San Fernando
Valley Arts & Cultural Center (18312 Oxnard St). He will review
the consequences of global climate change, threats to California and
will speak to what we can do as individuals, and as a group, to make
a difference. Refreshments included, parking in the back.

BOOK NOW THROUGH FEBRUARY 29, 2020!
ASK YOUR AAA TRAVEL AGENT ABOUT CURRENT
OFFERS AND OTHER DESTINATIONS

Community Calendar

* The New Year is a time to create a clean slate. Join Doug
Frankel for a powerful meditation workshop at the Encino Tarzana
Library on Saturday, January 18, at 11 am. Doug has been inspiring
audiences on how to practice and learn this very simple technique,
which provides many benefits. Bring joy, peace and relaxation into
your daily life.
* Interested in learning how to create your own memoir?
Join the Tarzana Community and Cultural Center for their 10-week
class that covers everything you’ll need whether you would you like
to create a keepsake record for your family or a book for publication.
Classes kick off on January 28 and run from 12:30 to 2 pm on every
Tuesday. The total class fee is $300, which comes to $30 per 1.5
hour class. Call 818.705.1286 to register.
* Balboa Sports Center is hosting a free lacrosse clinic for
boys and girls on Saturday, January 18, starting at 2 pm. The clinic is
designed to teach basic lacrosse skills and is intended for the player
who will be starting lacrosse for the first time and/or who wants to
find out if the sport is appropriate for them. No prior experience is
necessary and all necessary lacrosse equipment will be provided.
For more information or to register for the clinic, please visit www.
SFVlacrosse.org
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People in the News
Tarzana attorney Steve Hornstein, left, has published
his new book. Creating Your Estate Plan (18 Rules to Follow
to Make Sure Your Estate Plan Will Work When It Needs To)
covers important questions such as “Do I need an estate plan?”
“Should I see an attorney or go to one of those ‘do-it-yourself’
websites?” “What documents should I have in my estate plan?”
Hornstein is an estate planning attorney as well as a
Certified Public Accountant and Certified Financial Planner.
As an attorney with Hornstein Law Offices, he has prepared
thousands of trusts and estate planning documents, and has
successfully litigated many estate planning cases at trial. He
is also past president of the West Valley Warner Center Chamber
of Commerce.

COMMUNITY

* The great George Carlin mused, “Have you ever noticed
that anybody driving slower than you is an idiot, and anyone going
faster than you is a maniac?”
* What if soy milk is just milk introducing itself in Spanish?
* You loved the paraprosdokians - for those of you that missed
them they are phrases with unexpected endings - so here are more!
		
- I want to die peacefully in my sleep like my
grandfather. Not screaming and yelling like the passengers in his car.
		
- Light travels faster than sound. This is why some
people appear bright until you hear them speak.
		
- How is it that one careless match can start a forest
fire, but it takes a whole box to start a campfire?
* When you think about it, good health is merely the slowest
possible rate at which one can die.
* In the 60’s people took acid to make the world weird. Now
the world IS weird, and people take Prozac to make it normal. Go
figure.
* Local reader John Stevens joked that as a New Year’s
resolution he was going to quit all his bad habits for 2020, but then he
remembered that nobody likes a quitter!

BURNT TOASTMASTERS
Seeking New Members!
Crespi Carmelite High School in Encino will be honoring their 2020 Hall of Fame inductees at a
special ceremony on Saturday, February 1, at 5 pm at the Alumni Memorial Gym (5031 Alonzo Ave).
The 2020 Hall of Fame inductees include (clockwise from left) Peter Bomar ‘03, Soccer, Pat Baker,
Head Cheerleading Coach, Sione Fua ‘06, Football and Wrestling as well as the 1981 Water Polo Team,
Div. 2 CIF Champions. For those interested in attending the ceremony, tickets are available at crespi.org.

Meet Every Thursday 7-9 am
Label’s Table Deli
19005 Ventura Blvd., Encino
Interested? Call Ron Rosate
818.284.0275
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EXTRA!
EXTRA!
Don’t miss this

UNPRECEDENTED
OPPORTUNITY

READ ALL ABOUT IT!
Blue Shield Plan F & G EXTRA

Limited Time Opportunity
Compare these L.A. Area rates with your plan!
Age Range

BS Plan F EXTRA

BS Plan G EXTRA

65 to 66

$163

$152

67 to 68

$177

$168

69 to 70

$197

$193

71 to 72

$214

$217

73 to 74

$232

$234

75 to 76

$268

$269

77 to 78

$302

$301

79 to 80

$341

$328

81 to 82

$373

$357

If you live in California and have any

83 to 84

$390

$385

Medicare supplement plan from any

85 plus

$410

$404

64 or younger

$972

$937

to change plans!

OFFER ENDS FEBRUARY 15.
a GUARANTEED ISSUE FROM ANY
MEDICARE SUPPLEMENT PLAN

company, you are guaranteed acceptance.
No health questions.

Additional couples discount of 7% available if enrolled in identical plan.
If "New to Medicare" $25 discount available for first 12 months.
Plan F available only if you became eligible for Medicare before 1/1/2020

They call it an

“Underwriting Holiday”
COMMONLY ASKED QUESTIONS
“What’s the difference between Plan F and G?”
With Plan F you have no deductibles.
With Plan G you are responsible for the
Part B deducible ($198 in 2020).
NO OTHER DIFFERENCES. SAME NETWORK
(Any provider that accepts Medicare.)
“Are the core health benefits the same
as on my current plan F?”
YES! IDENTICAL BENEFITS. SAME NETWORK
“Will my doctor accept this plan?”
Any provider that is “contracted with
Medicare” anywhere in the USA should accept
this plan.

PAUL DAVIS

Plan F Extra includes the following extras
(not covered by Medicare), using network providers:
a SILVER SNEAKERS – free gym network membership
a VISION BENEFITS – exam, eyewear allowance
a HEARING BENEFITS –
annual exam + hearing aid discounted pricing
a PERSONAL EMERGENCY RESPONSE SYSTEM –
device and monitoring
Plan G Extra – Same benefits as Plan F Extra except:
a Does not include Personal Emergency Response System
a Does Add $100 per quarter in FREE Over the Counter Items
(stuff you purchase every month)

CA LICENSE

#0M47932

Voted “Best Insurance Agent” for 18 years
by readers of the Daily News 2002-2019!

20

0 2 -2 01 9

Call us at 818-888-0880
www.pdinsure.com

Is This a Good Time to Review Your
Medicare Options?
By Paul Davis
We encourage everyone
to use the Annual Election Period
(October 15 to December 7) as
the ideal time to review your Part
D prescription drug plans and
Medicare Advantage plans. You
can change your Part D plan or
change your Medicare Advantage
Plan. During that time period you
can enroll in a plan even if all you
have is Medicare Parts A and B.
If you are currently
enrolled in a Medicare Advantage
plan and are not happy with
your choice, you may still be
able to make a change during
the Medicare Advantage Open
Enrollment Period (January 1 to
March 31).
In California, the ideal
time to review your Medicare
Supplement plans is around
your birthday. California has a
law that guarantees the right to
change plans within 30 days of
your birthday to any company’s
similar or lesser Medicare
supplement plan. We call it the
“birthday rule”.
Blue Shield announced
last year an “Underwriting
Holiday” from December 1,

2019 to February 15, 2020. They
have opened up their Medicare
Supplement Plans F Extra and G
Extra to anyone on any Medicare
health plan. You can apply
without answering any health
questions (if you are over 65)
and enroll in one of those two
Medicare supplement plans. This
is an unprecedented opportunity
to change plans.

In California, the
ideal time to review
your Medicare
Supplement plans is
around your birthday.
New for 2020:
If
you turned 65 after January 1,
Medicare Supplement Plans
C and F are now closed for
enrollment. If you are already on
a Plan F or C you can continue
with that plan indefinitely. Plan F
has been the richest plan available
since 2010. With Plan F you have
no deductibles or share of cost
when seeing Medicare contracted
providers for Medicare covered
services.
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Plan G by default
becomes the richest plan
available for new 65-year-olds.
The only difference between Plan
F and Plan G is that with Plan G
you are responsible for the Part B
deductible ($198 this year). Rates
are lower for Plan G than for Plan
F. We have already moved a
number of our clients from Plan
F to Plan G because the monthly
premium savings covers the Part
B deductible by a good margin.
We expect Plan G to be the most
popular plan going forward.
Paul Davis is owner of
Paul Davis Insurance Services.
For more information call (818)
888-0880 or visit www.pdinsure.
com.

The Nest Issue of the Encino Enterpise
Will Be Out On February 6

CULTURE EDITOR
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HEALTH EDITOR
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Blvd. #303, Woodland Hills CA 91364. Phone 818.313.9545 / Fax 818.302.1417.
Email valleynewsgroup@gmail.com. Website: www.valleynewsgroup.com. Opinions
expressed in articles are those belonging to the article’s author and do not necessarily
reflect the view of the Publisher or its advertisers. Submissions are welcome and must
include name, address and phone. All submissions become the property of the Publisher.
Valley Vantage is a legally adjudicated newspaper of general circulation serving the
County of Los Angeles by Superior Court Degree No. SFC 858.

PHONE 818.313.9545 FAX 818.302.1417
Email: EncinoEnterprise@gmail.com
22025 Ventura Blvd. #303 Woodland Hills CA 91364
www.valleynewsgroup.com
Facebook.com/valleynewsgroupwoodlandhills

REGISTER FOR A FREE DIGITAL
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Get the Paper Deliverd Directly to
Your Inbox Bi-Monthly
Email us at EncinoEnterprise@gmail.com
and say

“Register Me”
Connect with Us on Social Media

valleynewsgroup.com

@ValleyNewsGroup

valleynewsgroupwoodlandhills
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Want to Reach Another 10,000 Homes? 5,000
Businesses? 12,000 Online Readers?
Call 818-313-9545

The New LA Yard
Get up to $15,000 rebate when you replace your grass
Vwith California Friendly® and native plants.
ladwp.com/landscaping

Inspirational Women
of the SFV

Nominations Now Open

The United Chambers of
Commerce recently announced
their Sixth Annual Inspirational
Women of the San Fernando
Valley Awards to be held on May
7, 2020 at the Hilton in Woodland
Hills. The event will recognize
women who have inspired,
achieved and made the San
Fernando Valley a better place.
Honorees will be selected from a
wide array of industries including,
but not limited to, business,
social services, health care and
medicine, education, community
advocacy, arts, government and
non-profit, among others. The
honorees will be selected by a
group of distinct individuals.
The selection committee will be
looking for women who have
made a profound impact in the
San Fernando Valley.
Nominations are now
open and self-nominations are
welcome. Last year’s recipients
were Arlene Alpert, Dr. Yvonne
Chan, Natalie Hill, Jean Sinatra
and Brenda Young.
Those
who
have
someone in mind are asked to

fill out a nomination form and
submit it no later than March 6,
2020. The form questions are as
follows:
“Nominee information:
Name:
Organization:
Title:
Address: Phone: Email:
Nominated by: Name:
Organization: Title: Address:
Phone: Email:
Please
tell
us
about the nominee and her
accomplishments, for example: 1.
Please describe how the nominee
has had a positive impact in the
San Fernando Valley 2. What
obstacles has the nominee
overcome and what impact did
it have on their organization |
company 3. Why is the nominee
inspirational to you? 4. Describe
how the nominee, formally or
informally has been a mentor.”
Send your nomination
by mail to the United Chambers
of Commerce, Attn: Marian Jocz
5121 Van Nuys Blvd., Suite 203
Sherman Oaks, CA 91403 or email
to Marian@unitedchambers.org.
For any further questions, call
(818) 981-4491.

Walk of Hearts
Teacher
Nominations

The Walk of Hearts Foundation
recognizes exceptional educators
for their commitment, innovation
and positive influence on their
students’ lives and are looking for
eligible recipients to be honored
this year! The Walk of Hearts
award is open to all who currently
teach, or have taught, in LA
County, both in public and private
schools.
Educators are selected via
nominations from their students,
school staff and the community
and are now being accepted
through March 1. The ideal
nominee is a teacher who is
motivating, stimulating and has
that unique ability to inspire and
perhaps, with a word or two of
encouragement, change a life.
This individual creates a positive,
pleasant and productive learning
environment while treating their
students with respect.
The Walk of Hearts
Foundation is a non-profit 501(c)3
organization who shares the
vision of founder Joe Andrews.
If you have a teacher in
mind, go to walkofhearts.org to
nominate that special educator
and show your gratitude!
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How to Improve Your Outlook
Performance for the New Year

By Andy Takieddine
Since we have entered
a new year, it is the best time to
look at your email system and
tune it for best performance. In
this article we are going to tackle
Microsoft Outlook system and
performance.
Ever notice that your
Microsoft Outlook account has
slowed to a crawl? Basic email
functions like send/receive acting
a little funny? Consider checking
the size of your mailbox. You
might be shocked to discover just
how bloated it is.
For most versions of
Outlook, clicking on File >
Folder > Properties > Storage —
or right-clicking on any folder
and selecting Properties — will
display the total size not only of
a chosen folder but also of any
associated subfolders.
Outlook’s Auto Archive
function is set to automatically
back up deleted items, sent items,
and expired tasks and calendar
items. But if you get hundreds
of messages per day and don’t
delete them or move them from
your inbox, you run the risk of
sabotaging your account. Exceed
2GB of storage in an overstuffed
inbox and Outlook really starts to
run slow.
Yet solving the problem
is doable. CMIT Solutions
recommends that you or your IT
support team follow the five steps
outlined below to change Auto
Archive’s settings.
1. Create a new local
folder or .pst (personal folders)
file to hold archived mail. Right
click on the “On My Computer”
heading at the bottom of your
folder list and choose “New
Folder.” Name the folder
Archived Mail or something
else that’s easily recognizable.
In older versions of Outlook,
you can select File>Archive and
change the date under archive
items older than.
2. Create a new Archiving
Rule. Click on Tools > Rules,
select Exchange from the “On My
Computer” section, and click the
+ near the bottom of the window.
Name the rule something
meaningful and recognizable,

like “120 Days, Auto Archive.”
3. Define the time limit and
destination for emails eligible for
archiving. Under the “when a new
message arrives” menu, change
Date Received (we suggest 120180 days) and then change “Do
the Following” to a defined action
like “Move Message + Archived
Mail.” Click the check box for
Enabled and click OK. In older
versions of Outlook, clicking
Tools>Options>Other>Auto
Archive brings up a similar set of
options.

Exceed 2GB of
storage in an
overstuffed inbox
and Outlook really
starts to run slow.
4. Run the new rule on
existing email folders. If you set
a new rule that all emails over
six months old will be archived,
don’t let aging messages received
before that rule was implemented
continue to clog up your Inbox.
Select the preferred mail folder,
click Messages>Rules>180 Day,
Auto Archive, and wait patiently
while your email account
reorganizes itself. Remember,
you’ll have to perform this
function on each desired folder;
also, Outlook uses “Last Modified
Date” to archive, not “Received
Date.”
5. Want to access your
archived emails? Simple —
they’re waiting for you right on
the left-hand column of folders
— or under the list of .pst files
on your computer — with all of
your other mail folders. The key?
They’re no longer taking up space
in your mailbox.
Of course, archiving
can’t cure all email diseases.
If you access your mail via an
Outlook Web App, any emails
archived on your local computer
won’t show up online — archiving
them means they’re no longer
hosted on the exchange server.
And a .pst file or archived folder
stored on your local hard drive

is still susceptible to disastrous
data loss if it’s not backed up as
part of your backup and disaster
recovery (BDR) plan.
Also, remember that
Outlook is not a real email
archiving solution — this
QuickTip will simply help you
free up storage space within
the program, NOT keep your
email secure via offsite backup
or searchable across years of
accumulated messages.
To learn more about
how CMIT Solutions can get your
Outlook account back in fighting
space and provide unparalleled
security for your email, stay
tuned for Part Two of our Email
Archiving QuickTip detailing
the benefits of CMIT RADAR
(Rapid Archiving, Discovery, and
Recovery) next issue.
For
professional
IT support and technology
services for your business, visit
cmitsolutions.com/Encino or call
(747) 239-2122.
Andy Takieddine is
the current president of CMIT
Solutions of Encino and an IT
executive who has spent over 30
years working for multinational
companies the likes of IBM, HP,

Jesus A. Lopez

Registered Representative
CA Insurance License #OC28958

5341 Alhama Drive Ste. 4
Woodland Hills, CA 91364
j.lopez@woodlburyfinancial.net

(818) 456-4770 Office
(818) 231-2877 Cell
(7818 456-4873 Fax

REGISTER
FOR A FREE DIGITAL SUBSCRIPTION
Get the Newspaper Delivered to Your
“Inbox”

Email “Register Me” to
EncinoEnterprise@gmail.com

Encino Enterprise, January 16, 2020, Page 8

ENTERTAINMENT CALENDAR

brought to you by
Community Blood Drive

The Village - LIVE!

The LAPD West Valley Division is holding a Community
Blood Drive on Tuesday, January 21, from 8 am to 8 pm in the
Community Room at 19020 Vanowen Street, Reseda. To schedule
your appointment, visit redcrossblood.org and enter the sponsor code
“BadgeSoCal” or contact Officer McKeighan at 818-374-7685 or
Officer Rios at 818-374-7683 to sign up. Donate blood in honor of
your favorite agency, help save lives and get a special Battle of the
Badges t-shirt!

A new year means new opportunities to listen
to music live at Westfield The Village every Thursday
from 4 to 8 pm. Whether you bring the family to sit
and listen or simply enjoy the melodies as a soundtrack
to your shopping, new and emerging local artists will
take to the stage by 24 Hour Fitness. The first session
of 2020 kicks off on January 16. Nothing’s better
than live music to lift your spirits and enjoy the world
around you!

dineL.A. Kicks Off

Therapeutic Floral Workshops

Kick off 2020 with some delicious meals as
dineL.A. Restaurant Week returns for its 15-day dining
event starting on January 17 and running until the 31st!
Highlighting the variety of culinary options that Los
Angeles has to offer, participating restaurants will be
curating specialty set menus for patrons to taste some of
their best dishes at a reasonable price. Lunch ranges from
$15 to $35, while dinner prices start at $29 and up. For a full
list of participating restaurants in the San Fernando Valley
as well as menu samples, visit discoverlosangeles.com/
dinela. Reservations are highly encouraged!

		
Enjoy therapeutic floral workshops every third
Sunday of each month at 12 pm at Via Floreal at Westfield Topanga
and The Village. The first session kicks off on Sunday, January 19.
While prices vary per workshop, each class is typically themed for the
season and all materials are provided. Unleash your creativity, learn
arranging techniques and successfully create a personal arrangement to
take home. Space is limited so those interested in attending are asked
to RSVP to 310-721-1373.

Comedy & Cocktails
Tarzana Community and Cultural Center
presents their signature “Comedy & Cocktails”
event on Friday, January 17, from 7 to 9 pm. Enjoy
a night of pure entertainment, featuring Jason Love
and his comedic cohorts Paul Morrissey and Robert
Lee. Wine and snacks are included in the ticket price
of just $25 in advance or $30 at the door. Doors open
at 6:30 pm. To purchase tickets, visit mytarzana.org.

GAP Sandbox VR
PINK The Children’s Place

Shampoo For Survivors

January is Human Trafficking Awareness Month and
Councilwoman Nury Martinez is hosting a Toiletry Drive now until
February 6. Help women survivors of human trafficking by donating
shampoo, conditioner, soap, toothbrushes, toothpaste, feminine hygiene
products, etc. (No travel size products). Donations can be dropped off
at the Van Nuys City Hall office (14410 Sylvan St. Ste 215). Donations
will be distributed between three organizations including CAST Los
Angeles, Journey Out, and Saving Innocence. For further info or
questions, call 213-473-7006.

Shoe Doctor Claire’s
Lorna Jane Hollister Co.

T:10”
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The cancer experts you trust,
now closer to you.
Cedars-Sinai Cancer Care Available In Tarzana
Cedars-Sinai is bringing comprehensive cancer care right to your neighborhood.
Now, getting the care you need is more convenient than ever with medical oncology,
radiation oncology, surgical oncology and imaging all under one roof.

T:14”

18133 Ventura Blvd, Tarzana, CA 91356

1-800-CEDARS-1

Most insurance plans accepted.

cedars-sinai.org/valley

© 2020 Cedars-Sinai

cedars
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Here’s to 2020

HEALTH AND FITNESS
Your whitest teeth.
Not in three months.
Not in three weeks.
By tonight.
Introducing Zoom!
Professional Teeth Whitening Centers.
The revolutionary new way
to whiten your teeth.

Now there’s a whole new way to whiten your teeth.
Without spending weeks with a bleaching kit or so-called whitening toothpaste.
Zoom!’s remarkable new technology is so effective, it can safely and gently
whiten your teeth to their ultimate natural whiteness - in just one visit.
And the results are guaranteed to your satisfaction. Just call Zoom! today.
And you could have whiter teeth by tonight.

Joseph P. Sciarra, D.D.S.
22554 Ventura Blvd., Suite 102
Woodland Hills 818.224.2970

Absolute Pilates Upstairs
21208 Costanso Street Suite 2
Woodland Hills, CA
818 226-0695
absolutepilatesupstairs.com
- Conni Ponturo

By Conni Ponturo
I couldn’t wait to bring
in the new year, 2020. I had
my plans and goals. My family
and I went away to beautiful
Newport Beach where we had
lots of activities
planned,
and
then it hit me. I
was sick and out
for the count.
I faked
feeling okay and
went
through
with everything
but all I wanted
to do was crawl
into bed. New
Year’s
Eve
came and went
and again I couldn’t wait to get
back into bed. When I finally felt
better the new year was off and
running and I realized that selfcare and compassion were my
strongest assets.
So, here are my feelings
as a Pilates teacher and wellness
coach for the past 20 years.
1: Be kind to yourself.
Move into January with ease and
love for yourself. Whether you

have been sick, depressed, sad,
lonely, out of sorts with your
life, out of work, or just out of it.
Kindness to yourself matters.
2: Pick one new idea
a week that you would like to
implement.
Walking
for
30 minutes a
day,
reading
instead
of
watching T.V.,
putting
your
phone
down
and having real
communication,
going to the
gym,
trying
a new Pilates
or yoga class,
meditation class, cooking class,
smiling at people, calling a
friend and making a lunch date,
do something different for you
so you can begin to see and
experience new adventures.
3: Sit in stillness for
five minutes. That’s all you
must do. Sometimes you need to
check out to check back in. Put
on the timer for five and sit in a
comfortable chair and breathe.
Ignore the stories that your mind
will tell you and relax into the
stillness. Especially when it is
uncomfortable.
4: Be willing to make
your health your number one
priority. Make better choices,
with your food. Cut your portions
down by 5%. Cut out sugar, eat
healthy fats, fruits and vegetables,
chicken, meat and fish. There is
no perfect diet, instead it is what
is perfect for you.
5: Go to bed. Sleep is
where we rest and restore our
body.
6: Get out into nature.
Go to the ocean, mountains, a
park, find some space to be still.
7: Hire a coach. Hire
someone that is going to propel
you into a healthier, happier,
lifestyle. There are so many of us
out there. Let us help you, with
a professional you get to your
desired goals so much faster.
8: Realize that this
new decade is going to go by so
quickly that before you know
it, February will be here. Take
small steps every day and when
2021 gets here, you will be in a
happier, healthier, situation.
Remember, your health
is your wealth.
Conni
Ponturo
is
the owner of Absolute Pilates
Upstairs in Woodland Hills.
She is a leading authority in the
field of pain-free living, which
includes the power of creating
a harmonious connection of
mindset, emotions, and body. She
can be reached at 818-226-0695.
Her book Falling Into Joy: Eight
Simple Steps to Allow Your Body
to Become Your Best Friend
is available for purchase on
Amazon.com.

What the Health?

By Allie Priore
The new year is a great
time to check in with your goals
and intentions for the year,
including your health. Most
people turn to physical activity
when they
think
of
health goals
for the year.
However,
it is just as
important
to
focus
on
your
nutrition and
what goes
into
your
body as well.
A lot of people use the
new year as a way to reset their
system or detox with clean eating.
Allowing your body this time
to reset is beneficial for many
reasons.
You can rid your body of
any toxins and start the new year
on a cleaner slate. There are many
different types of plans or tools to
try, and depending on what your
goals are, these can help you
determine what you want to do.
As with all major changes to your
diet, be sure to check in with your
doctor prior to any drastic eating
habits especially if you are on
certain medications.
Below are some of the
various plans or tools for you to
try:
Whole 30 — The basic
idea is to eat solely whole foods,
meaning nothing with added
sugars, nothing with dairy and
no alcohol. Due to its popularity
there is a plethora of information
online to help guide you in what
you can and cannot eat, and even
actual recipes you can follow. The
plan is 30 days long and the goal
is that at the end you learn to love
how your body feels from eating
foods that genuinely fuel it. Most
people use this as a reset and after
completing, introduce sugars,
dairy and alcohol back into their
lives. However, the cravings for
those kinds of food and drinks
have lessened and helps you lead
an overall healthier lifestyle.
Keto — The goal of this
plan is to get your body into a
state of ketosis which is a state
where your body efficiently burns
fat for energy. You achieve a state
of ketosis from eating low carb
and high fat foods. There is a lot
of information available about
how to achieve ketosis and what
kinds of foods to eat or avoid so
check online for more detailed
information.
Intermittent
Fasting
— This eating pattern focuses
more on when you eat rather
than on what you are eating.
When following this plan you
are switching between periods
of fasting and eating. There are
multiple ways to implement

your fast with the most popular
breakdown being a fast of 16
hours with an eight hour eating
window. However, some people
fast two days a week by cutting
down their caloric intake and some
people
fast
for
an entire
24 hours.
You may
already
naturally
fast
if
you tend
to not eat
breakfast
and don’t
eat
past
dinner.
Perhaps none of the
above seems like the right plan
for you and that is okay. Focus
on making the lifestyle changes
that work for you. Maybe its
something small like simply
cutting back on sweets or
increasing your water intake.
Maybe you eliminate sugar
completely from your diet.
There are so many ways
to help reset your body and feel
refreshed. Think about what you
eat, be mindful and conscious in
your decisions and you will be
on your way to a healthier way of
living in no time.

Allie Priore is a certified
Pilates instructor based in the LA
area and has been a professional in
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Let’s Feel Better California!
By Tom Vitorino
I am sure by now you
have heard about CBD, short for
Cannabidiol (1 of 100 chemical
compounds in cannabis known
as Cannabinoids). Maybe you’ve
driven past a CBD sign in a
marijuana dispensary window, a
friend might be taking it, maybe
you even have tried it. Like
everything else in the world, be
it canned peaches or a cabin on
a cruise ship, there are different
levels of quality, and not all
CBDs are created equal.
Let me tell you about my
experience with CBD. Five years
ago I had a cataclysmic foot injury
that left me with a foot full of
titanium, several inches removed
from my tibial and achilles tendon
and my doctor telling me I was
pretty much bound for a limp, and
running was a thing of the past.
For my pain, which was real, and
constant, I had a prescription for
opioids. They work, I was free
of pain, and free of my ability
to think clearly, be productive in
my job, but more importantly be
an active member of my family.
There had to be a better way.
In the fall of 2015 I
started searching online, reading

a lot about CBDs. I basically
went to a self imposed CBD boot
camp, reading everything and
trying just about every product on
the market. I learned all I could
about CBDs. Then I went past
the reading, and sampling, and
engaged the CBD manufacturers
big and small. It became clear
to me that there was not one
category of CBD, or a high
standard. Some were ineffective,
some did the job, but being
charged $300 for a one-month
supply created a whole new pain,
a pain in my wallet! Fed up with
price gouging for the effective
products or THC laced CBD that
was just another way to get high,
I head hunted the right team, and
created California’s Best CBD.
Our products are for people who
are serious about their health and
well-being.
So let me be clear, there
is no THC in our CBD products,
none, zero, zilch, nada. If you
like the buzz of THC, this is not
a product for you. However, if
you want an effective, affordable
product for managing your pain
be it chronic or temporary, we’ve
got your back. . . . knee, elbow,
neck, etc., covered. If you are in

pain as you read this, if you have
been told, “well you are getting
older and you will have to live
with pain”, if you are taking
an Ibuprofen product for pain,
knowing it is damaging your
liver; now is the time, today is
the day, this is the year. Turn over
a new leaf, a THC free cannabis
leaf if you will.

Fed up with price gouging
for the effective products
or THC laced CBD that was
just another way to get
high, I head hunted the
right team, and created
California’s Best CBD.
Visit us at www.
CAbestCBD.com,
use
our
discount code CABEST15 for
15% off and free shipping.
Let’s get started, and let’s FEEL
BETTER CALIFORNIA! Oh,
and as for me and my foot: I just
finished a 5k this weekend, pain
free, and in the best shape of my
life.
Tom Vitorino is the
founder of California’s Best CBD.
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Call 818-313-9545 to Advertise

How to Strengthen Your Documents
BEFORE Your Health Fails

By Sandy Rosenholz
Are you constantly
being
bombarded
with
information
about
senior
healthcare options? Do you
receive so much information
that you can’t decide what
is necessary and what is just
a sales pitch? How do you
determine which documents
are critical to your individual
care and well-being, and which
are not? To help clarify things
for you, we have singled out
five documents that we believe
seniors should include in their
files.
1.
HIPPA
Authorization Form.
With the restrictive
nature of the HIPPA (Health
Insurance
Portability
and
Accountability Act) of 1996,
which regulates who can
receive information on your
healthcare, having a HIPPA
Authorization Form is essential.
The paperwork authorizes
a healthcare professional or
provider to share information
with a family member, guardian,

conservator, or anyone else you
might name.
2. Durable Power of
Attorney for Healthcare/Health
Proxy.
If you already have
a revocable trust, then you’ve
likely named a healthcare proxy,
someone who can make decisions
on your behalf when you are no
longer capable of doing so. A trust
will also cover numbers three and
four on this list.
3. Durable Power of
Attorney for Finances.
This document gives
legal power to someone of your
choosing to handle your finances
if you are unable to do so,
including paying those healthcare
bills.
4. Do Not Intubate/Do
Not Resuscitate.
Many people believe
that Do Not Intubate (DNI) and
Do Not Resuscitate (DNR) orders
are the same; however, they are
not. DNR refers to refusing lifesaving measures. DNI refers to
having a breathing tube inserted
in your airway connected to a
ventilator to help you breathe
better. However, sometimes
DNR orders include DNI orders.
It’s essential to ask your legal or
healthcare professional about this
when you fill out the paperwork.
5. POLST.
The Physician’s Orders
for Life Sustaining Treatment is
a document often recommended
in the case of terminal or chronic
illnesses. This order is created
by your physician and should be
updated as your health changes.
POLST offers yet an extra
layer of protection for patients
and physicians to ensure that
the specific medical condition,
the patient’s values, and goals
for treatment are defined for
caregivers. Additionally, POLST
allows you more control over
treatments you want or don’t
want to receive.
Other Considerations:
Filling out the above-mentioned
forms is a good start. But there

are several other issues that must
be considered to make sure the
documents will serve your needs.
A few of these considerations are
listed below.
Moving Your Residence.
If you move to another state
either to seek treatment or
due to a new living situation,
you’ll want to check to find out
whether the documents created
in, and approved by the state of
California, will hold up in another
state. And if they will not function
as they were meant to, what steps
do you have to take the rectify the
situation.
Think Ahead. Complete
the documents before your health
deteriorates to the point that you
need them. Make sure you acquire
these documents, fill them in and,
if necessary, get them notarized
before your health begins to
decline. Too often this paperwork
is made out at a hospital bedside
or, in some instances, not at all.
Provide
Copies
to
Others. Make sure that your
healthcare professionals and
contacts have copies of these
documents so that they understand
the parameters you have set for
your care.
Share the Location of
the Documents. Tell those closest
to you where the documents are
so that they can follow through
with your wishes. It’s not enough
to want things to turn out a certain
way, make a plan, and share it
with those in your inner circle.
It’s the only way to make sure
your wishes are carried out.
Sandy
Rosenholz,
owner of Senior Resources,
Inc. helps seniors transition
from their current residence to
an active senior community,
assisted living, board and care
or skilled nursing depending on
the level of care required, or can
provide non-medical caregivers
anywhere you need them. To
reach Sandy, call 818-3592125, SR@SeniorResourcesCA.
com or visit his website, www.
SeniorResourcesCA.com.

Sinus Solutions 101

By Marc Kerner, MD, FACS
attack, which contributes to
When is a cold actually sinus blockage. It can worsen
sinusitis?
by
exposure
to
The majority
environmental
of sinus infections are
pollutants.
Unlike
caused by bacteria
colds or allergies,
that become trapped
bacterial
sinusitis
in blocked sinuses.
requires a physician’s
Bacteria flourish in
diagnosis
and
the sinuses creating
treatment
with
symptoms of runny
antibiotics to cure the
nose,
congestion,
infection and prevent
facial
pain
and
future complications.
Dr Marc Kerner
Normally,
mucus
pressure.
Sinus
infections are usually
collecting in the
preceded by a cold or allergy
(continued to page 14)

Meditation for Your
Mental Health

By Larise Kia Megerdichian
When we think of
health, we may immediately
think of eating well balanced,
nutritious food and maintaining
regular physical activity, yet for
maintaining a healthy mind we

overlook and overthink, creating
stress. Culturally we are not
taught how to maintain an overall
health of the psyche that has been
overwhelmed by fragmentation.
This dispersal is caused by
experiences of alienated feelings
due to the environment growing
up which created confusion and
trauma.

The aim in meditation
is not to stop thinking
but rather be fully
present with whatever is
relevant in the moment
without trying to change
or judge it.
Meditation is an ancient
practice that creates the ground
for integration and stabilization
of the fragmented parts of the
mind. Meditation is our most
natural state of existence.
A phenomenon that
has been completely forgotten
throughout centuries due to the
psyche’s need to defend itself
from external forces of power

and control, meditation is a deep
resting space on the innermost
states of peace. In this stage peace
hasn’t left us, we have abandoned
it!
The aim in meditation
is not to stop thinking but rather

be fully present with whatever is
relevant in the moment without
trying to change or judge it. The
intention in meditation is to find
the observer’s seat within and
learn to deeply listen, establishing
a relationship with inner
spaciousness. Resting in deep
observation deepens an inner
container where fragmented parts
can integrate. This integration
happens naturally when one
practices meditation on a regular
basis, strengthening the muscle
that pulls and directs awareness
by will.
It cannot be stressed
enough that meditation is food for
the mind, body and soul.
Larise
Kia
Megerdichian is the founder of
Bindupoint, Center for Presence
and was brought forth from her
unwavering devotion, dedication
and tenacity to share practices of
healing, strength and oneness.
For information on
their schedule, variety of classes
offered and class packages, give
them a call at (818) 616-4779 or
visit their website at bindupoint.
com.
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Is Dry January a Safe Resolution?

As a New Year begins,
one of the resolutions that seems
to reign popular with many is the
adoption of “dry January” or the
period of eliminating all alcohol
intake for 30 days. For some
it serves as a kicking off point
to vow to drink less in the new
year not only for the betterment
of their health, but also for their
wallet.
Some simply use the dry
period as a way to detox from
the heavily fueled holiday season
and give their liver a break before
introducing alcohol back into
their diet the following month.
Yet all seem to claim that limiting
alcohol intake is beneficial for
their overall health. So is dry
January actually a beneficial tool
to be utilized? Experts say that
it can be if done the appropriate
way.
First, consumers are
advised to look at their baseline
drinking habits and then clearly
state why they want to take part
in “dry January.” For someone
who drinks an occasional glass of
wine, this deprivation period will
most likely not do much for him or
her. However, for someone with a
more moderate drinking pattern,
abstaining from alcohol abruptly
could cause mild, but obvious,
withdrawals like headaches. Yet,
once that upsides, your body will
be running clearer and cleaner.
Taking a one month
break won’t recalibrate your
drinking patterns or health, so it’s
important to evaluate why you

want to partake in dry January
and the steps you plan to take
once the month ends.
Perhaps the biggest
benefit is seeing how your body
functions (mentally, emotionally,
physically, socially, etc.) without
the dependence on alcohol. Are
you sleeping better? Getting
through your workouts easier? Is
your skin feeling more hydrated?
During this flu season,
it could also be beneficial to your
immune system. Intoxication can
suppress your immune system
making you more susceptible to
pathogens. Alcohol doesn’t kill all
germs! Drinking less, consuming
more water and having more
energy could up your chances of
not catching the flu.
Once the month is
up, evaluate how it went. Do
you feel better? Have you lost
weight? Saved money? Thinking
a bit clearer? Do you just miss
the social aspect of drinking?
While the pattern of indulgeabstain-indulge is never highly

We don’t say we’re
the most fun retirement
community around.
{ our residents do }
Our residents talk about us. A lot. They love to
talk on-and-on about all the fun they have at
Fairwinds – West Hills. In fact, sometimes it’s
enough to make a retirement community blush.
Come see what we mean. Call (818) 275-0712
to schedule your complimentary lunch and tour.
And, just so you know, we’ll be doing some
talking, too. About our fun residents.

It’s More Than Retirement. It’s Five-Star Fun.

8138 Woodlake Avenue • West Hills
(818) 275-0712 • fairwindswesthills.com

recommended by any health
professional, dry January can
be a crucial evaluating period if
done correctly to see what your
relationship with alcohol is. It’s
also important to note that your
tolerance will also be lower if you
do decide to start drinking again
so it’s important to return to it
slowly.
While dry January is
extremely popular, it doesn’t need
to be the first month of a new year
to evaluate your drinking habits.
Pick any month that suits your
schedule and see how much of a
difference it could possibly make
to your well-being.
According
to
psychologists,
it
takes
approximately 21 days of
conscious and consistent efforts
to create a new habit but breaking
an existing habit can take
considerably longer. Patience is
key and while it may take baby
steps to ultimately reach your
goal, the bigger picture could be
worth it.
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UCLA Health Zone with Dr. Phillip
Sinus Solutions Cont’d
Cohen: Worth a Listen
HEALTH & FITNESS

(continued from page 12)
sinuses drains into the nasal
passages. When people have a
cold or allergy attack, sinuses
become inflamed and unable to
drain, leading to congestion and
repeated infections. Diagnosis of
acute sinusitis usually is based
on physical examination and
discussion of your symptoms.
X-rays of your sinuses or a sample
of your nasal discharge is used to
test for bacteria.
When
does
acute
become chronic sinusitis?
When you have frequent
sinus infections, or the infection
lasts three months or more, you
most likely suffer from chronic
sinusitis. Symptoms of chronic
sinusitis may be less severe than
those of acute sinusitis; however,
untreated chronic sinusitis can
cause damage to the sinuses and
can require surgery to correct
the blockage and relieve the
symptoms.
What are treatment
options?
Bacterial
sinusitis:
Therapy for bacterial sinusitis
includes appropriate antibiotics.
In addition, oral or nasal spray or
drop
decongestants
may
be recommended to relieve
congestion.
We do not recommend

prolonged use of nonprescription
nasal sprays or drops. Inhaling
steam or using saline nasal
sprays or irrigations are effective
to relieve sinus discomfort.
Diagnosis can be made by
looking into the nasal cavity
with a small endoscope and
if necessary an X-ray scan of
the sinuses can be taken. If it
is determined that your sinus
passages are narrowed or blocked
leading to symptomatic sinus
infections or chronic sinusitis,
there are now a number of stateof-the-art options to correct this
condition. The latest is Balloon
Sinuplasty, which is a minimally
invasive procedure for patients
suffering from sinus blockage.
The procedure is performed in the
office under local anesthesia and
allows patients rapid recovery.
The technology for this procedure
was adopted from angioplasty
in which small balloon catheters
are used to dilate either blocked
vessels, or in the case of sinuses,
blocked drainage pathways.
Minimally invasive surgery is
also available to correct anatomic
deformities, which lead to
obstruction of the sinuses.
For more information
on Dr Marc Kerner please visit
www.calwestent.com or call 818349-0600.

By Laura Levinsky
In a world where some
doctors believe in the brevity
of the spoken word or visit, Dr.
Phillip Cohen is just the opposite.
As host of the eponymous “UCLA
Health Zone with Dr. Phillip
Cohen,” he uses the spoken word
to inform, teach and generally
communicate with the public at
large.
Growing up, he wanted
to be a professional baseball
player, but realized it wasn’t
going to happen. He had always
been interested in medicine, so
if he couldn’t be a ball player,
he would do the next best thing,
and would work with them. The
world of sports medicine and the
general population is the better
for it.
After an education at
UCLA and a stint at Rutgers
in New Jersey, he returned to
Southern California and UCLA.
When the School of Medicine
was looking for someone to do a
radio show, Dr. Cohen was right
there, ready and willing. The
weekly radio program led to a
podcast and the job of hosting it.
Dr. Cohen considers it on-the-job
training.
The show covers more

than just sports injuries of the
professional athlete. It is actually
meant to help the average person
with questions about their health.
In fact, that is where the majority
of the questions come from, the
average person.
While it has the
occasional
athlete-centered
conversation, the show is meant
for the average listener and health
topics that affect them.

Your health may just
thank you for listening.
Still, Dr. Cohen does
specialize in sports medicine. So,
what is the sport with the most
injuries? According to Dr Cohen,
the answer isn’t what you would
expect. The worst thing is being
a couch potato. A sedentary
lifestyle is more likely to lead to
ill health and injury when you do
exert yourself. So do yourself a
favor and keep moving. It doesn’t
matter what sport you choose,
just keep active.
Public interest in the
podcast is growing. More people
are tuning in or listening at their
leisure. Take some time while
you are sitting in traffic. Your

Podcast host Dr. Cohen
health may just thank you for
listening.
“UCLA Health Zone
with Dr. Phil Cohen” airs every
Saturday from 8 to 10 am on
AM570 in Los Angeles.
Dr. Cohen, an internal
and sports medicine specialist
with the UCLA Health Encino
medical practice, is joined by
co-host Adam Ausland and
weekly guests to talk about sports
injuries, treatments and general
health information for athletes
and weekend warriors alike.
Laura Levinsky is a lifelong Valley resident and a regular
contributor to the Valley News
Group.

Chick-Fil-A Traffic Jams

Open since October
2019, the Chick-Fil-A at White
Oak and Ventura has seemingly
created quite a stir during the few
months it has been in operation.
While renowned for
their chicken dishes, it’s the
influx of traffic this location has
caused in the neighborhood that
is really getting people talking.
It takes only a quick glance at
their Yelp page to recognize the
frustrations of the drive-thru
that backs up traffic into the
residential neighborhood. Others
lament that when you turn south

Councilmember Paul Koretz on
proposed plans to alleviate the
traffic. A representative from
Koretz’s office responded to our
inquiries on what actions are
being taken in response to the
numerous complaints from locals
in the area. Their statement is as
follows:
“Our office has had
several meetings both onsite and
offsite with the Department of
Transportation (DOT) and the
Operation Manager in which we
debriefed about the recent grand
opening, daily operations, and the

on White Oak from Ventura, you
have to make an illegal U-turn
to even enter the line. There is
no indoor seating provided, so
the majority of customers utilize
the drive through, leading to a
backup of vehicles waiting for
their orders to be fulfilled.
Numerous
readers
have reached out not only
to the Encino Enterprise to
seek answers, but also to

current impact of traffic at this
location. We are working closely
with DOT to investigate possible
improvements for this site based
on the associated concerns
that we have received from the
community.
In addition, the Zoning
Administrator Officer is also
monitoring the situation and
documenting
all
materials
received on the matter. One of the

conditions of the grant requires a
Plan Approval process prior to
the completion of one year of
operation but because of all of the
complaints and problems we are
asking the Zoning Administrator
to consider pushing that to a
potential earlier review.”
More on this story as
zoning reports are completed.
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Showcase Your Hot Properties
Here!
Call 818-313-9545

*
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*except 6200 Canoga
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Schedule a
little
time

See UCLA doctors in your neighborhood
Making your health a priority is now easier than ever. With primary and specialty care locations
in Encino, UCLA doctors are where you need us, when you need us. Because when it comes to
your health, we go out of our way to make sure you never have to.
• Family Medicine

• Dermatology

• Pain Medicine

• Internal Medicine

• Digestive Diseases

• Plastic Surgery

• Pediatrics

• Endocrinology

• Pulmonary Medicine

• Allergy & Immunology

• Hematology/Oncology

• Radiology

• Cardiology

• Infectious Diseases

• Rheumatology

• Critical Care Medicine

• Nephrology

• Sleep Medicine

• Orthopedic Surgery

• Sports Medicine

15503 Ventura Blvd., Suites 150, 170, 340 Encino, CA 91436
1-800-UCLA-MD1 (1-800-825-2631)

uclahealth.org/encino

uclahealth.org/getsocial
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